## Table of Contents

1. USB-2-MDIO Description ........................................................................................................... 3
2. USB-2-MDIO Tool Setup and Use ........................................................................................... 3
   2.1 Hardware Setup MSP430G2 Series ................................................................................ 3
   2.2 Hardware Setup MSP430F5 Series ................................................................................ 5
   2.3 Software Setup ............................................................................................................... 7
The USB-2-MDIO software tool allows users of Texas Instruments' Ethernet PHYs to access MDIO status and control registers. The USB-2-MDIO tool consists of an MSP430 LaunchPad™ interfaced with a lightweight GUI. The LaunchPad implements an MDIO bus controller that can manipulate registers on PHYs attached to the bus.

1 USB-2-MDIO Description

USB-2-MDIO software tool is used to configure the registers of a PHY using the MSP430 LaunchPad. This development tool allows for simple hardware setup and software support for customers that do not have MDIO communication capability.

USB-2-MDIO allows access to all Texas Instruments' Ethernet PHYs that support MDIO bus serial management. USB-2-MDIO allows users to read, write, script register read/write transactions and log data coming from the MDIO bus.

2 USB-2-MDIO Tool Setup and Use

An MSP430 LaunchPad is required for use with this GUI and can be purchased at the TI eStore (https://store.ti.com/MSP-EXP430G2-MSP430-LaunchPad-Value-Line-Development-kit-P2031.aspx).

The MSP430F5529 variant of the LaunchPad supports a range of VDDIO levels allowing communications with PHYs at 1.8-V VDDIO (https://store.ti.com/msp-exp430f5529lp.aspx).

MSP430 drivers are required to properly connect the MSP430 LaunchPad to a user’s computer. Drivers can be downloaded at http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430_FET_Drivers/latest/index_FDS.html.

2.1 Hardware Setup MSP430G2 Series

The LaunchPad should be set for HW UART mode. This setting is enabled by configuring the jumpers at J3. Figure 1 shows the proper jumper configuration to enable HW UART mode.
Figure 2 shows the necessary connections to enable MDIO register access. MSP430G2 Series LaunchPad pin configurations are as follows:

- MDIO (EVM) Connect to P1.5 (LaunchPad)
- MDC (EVM) Connect to P1.4 (LaunchPad)
- GND (EVM) Connect to GND (LaunchPad)
2.2 Hardware Setup MSP430F5 Series

The MSP430F5 Series LaunchPad is an upgraded version of the MSP430G2 Series LaunchPad. This LaunchPad is capable of interfacing with a range of I/O voltages (3.3 V to 1.8 V). To properly configure the F5 Series, the user will need to remove the 3V3 jumper located between the 5V and RTS jumpers. Connect the desired I/O voltage to the 3V3 header located at J10.

MSP430F5 Series LaunchPad pin configurations are as follows:

- MDIO (EVM) Connect to P4.1 (LaunchPad)
- MDC (EVM) Connect to P4.2 (LaunchPad)
- GND (EVM) Connect to GND (LaunchPad)
Figure 4. MSP430F5 LaunchPad Connections, MDC (Green Wire, P4.2), MDIO (Brown Wire, P4.1), and GND (Black Wire)
2.3 **Software Setup**

The USB-2-MDIO GUI allows communication to 32 different PHY IDs, register access to both extended register and standard registers, and ability to save data read and run script text files.

2.3.1 **Flashing MSP430G2 LaunchPad**

For the GUI to properly work with the MSP430 LaunchPad, USB-2-MDIO software will need to be installed on the LaunchPad itself. Both the Green and Red LEDs will be fully illuminated without blinking if it has the correct software installed. If the device is already flashed, you may skip the steps below.

Flashing on the MSP430 LaunchPad requires the MSP430 Flasher tool which can be downloaded at [http://www.ti.com/tool/msp430-flasher](http://www.ti.com/tool/msp430-flasher).

The MSP430 Flasher tool should be extracted into a folder called `MSP430Flasher` inside of the folder containing the batch script executed in step 3 below.

To properly flash the MSP430G2 Series LaunchPad, use the following steps:
1. Connect MSP430 LaunchPad to user’s computer using a USB cable.
2. In the directory where the USB-2-MDIO tool was installed, navigate to `..\MSP430 Firmware\` and double click to open.
3. Locate `Flash_MSP430_G2.bat` and double click to run the program.
4. The batch file will execute and a command window will appear.
5. After the program successfully executes, the MSP430 LaunchPad Green and Red LEDs will be fully illuminated without blinking. If they are not in this state, the MSP430 LaunchPad has not been successfully flashed.
6. Repeat steps 1 through 5 for MSP430F5 Series LaunchPad, but use `Flash_MSP430_F5.bat` file instead.

---

**NOTE:** MSP430 drivers are required to properly connect the MSP430 LaunchPad to a user’s computer. Drivers can be downloaded here: [http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430_FET_Drivers/latest/index_FDS.html](http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/MSP430_FET_Drivers/latest/index_FDS.html).
2.3.2 Connecting to USB-2-MDIO GUI

1. Unzip and install the GUI.
2. Launch USB-2-MDIO.exe from the Windows Start menu or the desktop.
3. Select the Settings tab located in the top-left corner.
4. Select COM Port and pick the port that the LaunchPad is connected to from the drop-down menu.

NOTE: To find what port the LaunchPad is connected to go to Device Manager on your computer and look under Ports. If the device is not found under Ports, please ensure that the drivers specified above are installed on the user's computer.

5. Select Baud Rate for 9600.
6. Click on PHY ID and select PHY ID desired from dropdown list found on the Main Page next to Port Status.
   (a) If the PHY ID is unknown, you may leave this box unselected and use the Find PHY ID option in the File drop-down menu after completing step 7 below.

7. Click Open Port to connect to the MSP430 LaunchPad.
8. The status bar under Port Status should be fully green if the connection is made.
9. To end communication with the port, click Close Port.
2.3.3 Find PHY ID

If a PHY ID is not known before operation, you can open the communication port and run the Find PHY ID command from the File menu using the following steps:

1. Ensure the communication port is open on the GUI.
2. Navigate to the File menu and select Find PHY ID.
3. The GUI will attempt to ping the PHY connected by sweeping through all 32 possible PHY IDs.
4. A list will begin to appear in the dialog box of each PHY ID and the status of each ID.
5. If a connected PHY responds, the dialog box will indicate that the PHY is available.
6. If a PHY does not respond at the pinged PHY ID, the dialog box will indicate that the PHY ID is not available.

2.3.4 Running a Script File

A script file can be run to read and write to the PHY registers. This allows for greater flexibility and improved efficiency since multiple reads and write may be performed. As an example, a script can be used to initiate and test 100M link internally in the DP83867 device. To perform the DP83867 100M test, perform the following steps with the DP83867 100M test.txt script file in the [installdir]/USB2MDIOTool/Scripts directory.

1. Navigate to File and select Open.
2. A dialog box opens and allows the user to select the DP83867 100M test.txt script file to initialize the DP83867 100M test.
3. Once the text file is selected, the script automatically runs and the results are printed in the dialog box below the Read and Write buttons.
4. Additional scripts may be created and executed using steps 1 through 3 above for all Texas Instruments' Ethernet PHYs.
2.3.5 Example Script

Below is an example script. Scripts should be written in a txt file using any basic text editor. An example script can also be found in the USB-2-MDIO GUI in the Help menu option titled Example Script

// This is how you make a comment. All scripts must start with 'begin'

begin

// To read a register, write the 16bit register address in hex (from 0000 to FFFF)
// The scripts are not case sensitive
// Example to read registers 0x0001, 0x000A, and 0x0017

0001
000A
0017

// To write a register, write the 16bit register address in hex (from 0000 to FFFF)
// followed by the 16bit value in HEX you desire to write to the register (from 0000 to FFFF)
// Example to write 0x2100 to 0x0000
// Example to write 0x0110 to register 0x0016

0000 2100
0016 0110

// As shown above, the register address does not have to be separated by a space from the
// value being written. If a space is desired, only 1 space should by inserted between
// register address and the value.

// You must end the script by adding 'end' once you are finished

end

2.3.6 Saving Data Results

Results can be saved at any time using the following steps:
1. Click File and select Save.
2. Select Save Data.
3. A box opens to allow the user to select the desired location to save the data in the dialog box and name the file.

2.3.7 Basic Read

1. Click the Extended Register drop-down menu and select Yes.
   (a) If extended register access is not required, or supported by the PHY, select No.
2. Enter the desired register to be read in the Register Address text box. (Note: Registers must be between 0000 and FFFF.)
3. Click Read to read the register.
4. Results display in the dialog box below the Read and Write buttons.
5. If an error occurs, use the Help box located in the bottom right corner of the GUI or contact the Texas Instruments Ethernet Group.

2.3.8 Basic Write

1. Click the Extended Register drop-down menu and select Yes.
2. Enter the desired register to be written to in the Register Address text box. (Note: Registers must be between 0000 and FFFF.)
3. Enter the desired data to be written to the register in the Data text box. (Note: Data must be between 0000 and FFFF.)
4. Click Write to write the data to the register.
5. Results display in the dialog box below the Read and Write buttons.
**IMPORTANT NOTICE**

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI's terms and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers' products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components which have not been so designated is solely at the Buyer’s risk, and that Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

<table>
<thead>
<tr>
<th>Products</th>
<th>Applications</th>
<th><a href="http://www.ti.com">www.ti.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Automotive and Transportation</td>
<td><a href="http://www.ti.com/automotive">www.ti.com/automotive</a></td>
</tr>
<tr>
<td>Amplifiers</td>
<td>Communications and Telecom</td>
<td><a href="http://www.ti.com/communications">www.ti.com/communications</a></td>
</tr>
<tr>
<td>Data Converters</td>
<td>Computers and Peripherals</td>
<td><a href="http://www.ti.com/computers">www.ti.com/computers</a></td>
</tr>
<tr>
<td>DLP® Products</td>
<td>Consumer Electronics</td>
<td><a href="http://www.ti.com/consumer-apps">www.ti.com/consumer-apps</a></td>
</tr>
<tr>
<td>DSP</td>
<td>Energy and Lighting</td>
<td><a href="http://www.ti.com/energy">www.ti.com/energy</a></td>
</tr>
<tr>
<td>Clocks and Timers</td>
<td>Industrial</td>
<td><a href="http://www.ti.com/industrial">www.ti.com/industrial</a></td>
</tr>
<tr>
<td>Interface</td>
<td>Medical</td>
<td><a href="http://www.ti.com/medical">www.ti.com/medical</a></td>
</tr>
<tr>
<td>Logic</td>
<td>Security</td>
<td><a href="http://www.ti.com/security">www.ti.com/security</a></td>
</tr>
<tr>
<td>Power Mgmt</td>
<td>Space, Avionics and Defense</td>
<td><a href="http://www.ti.com/space-avionics-defense">www.ti.com/space-avionics-defense</a></td>
</tr>
<tr>
<td>Microcontrollers</td>
<td>Video and Imaging</td>
<td><a href="http://www.ti.com/video">www.ti.com/video</a></td>
</tr>
<tr>
<td>RFID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OMAP Applications Processors</td>
<td></td>
<td><a href="http://www.ti.com/omap">www.ti.com/omap</a></td>
</tr>
<tr>
<td>Wireless Connectivity</td>
<td>TI E2E Community</td>
<td>e2e.ti.com</td>
</tr>
</tbody>
</table>

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated